
SmartPlant Instrumentation Technical User Forum  
P2C2 (Houston SPI TUF) Meeting 

May 5, 2009
8:00 am

The Shaw Group

Attendees 35 Members in attendance 
6 Online  via Net Meetings 

 Copied To 
 

LTUF Members  

Called By John Dressel Prepared By Daniel Lopez 
 

Item Topic Notes Action/Due 

1 Call to Order • John Dressel called the meeting to order & welcomed user 
group to The Shaw Group 

• Vicki Hutson, Welcome to The Shaw Group Inc.and gave a 
short safety orientation  

2 Chairman’s 
Notes 

Chairman’s Notes and Upcoming Conferences  John Dressel 
Currently being held: 

2009 Offshore Technology Conference  
May 4 - 7, 2009  
Reliant Center  
Houston, TX 
 
Global LTUF to be held Sunday, prior to Convention. 
Intergraph 2009  
June 15 - 18, 2009  
Gaylord National Convention Center  
Washington, D.C., 

 
Emerson has more dynamic interfaces than any other supplier, John 
Dressel will be making a presentation at this event regarding SPI and 
the interfaces. 

2009 Emerson Exchange  
September 28 - October 2  
Gaylord Palms Convention Center  
Orlando, Florida 

 

In the Fall meeting, ISA will embrace SPI much more than in the 
past.  They have invited the Houston-LTUF to host our 3rd Quarter 
meeting at their forum.  Also a Houston LTUF to establish a SPEC 
200 Specification steering committee. 

ISA EXPO  
October 6 - 8, 2009  
Reliant Center  
Houston, TX 

3 Introductions Introductions from all Attendees and those online attending the 
meeting with Webex were acknowledged, Dee Dee with Conoco in 
Borger Texas, Mich MacDonald , Michelle Syncrude Canada and 
Stephen Convens of Invensys. 

4 Minutes  Minutes of last meeting approved 
 

5 Shaw Group 
Presentations 

Shaw Corporate Profile 
Shaw Energy & Chemicals  
Business Sectors & Technology 
E&C Scope of Services 
Shaw E&C Worldwide Locations 
E&C Workshares 
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  Meeting Notes 

Item Topic Notes Action/Due 

•Business model since mid 90’s 
• High Value Centers 
• Shared Resources 

•Current E&C Workshares 
• Every major project 
• Many Proposals 

3D Workshares 
• PDS & SP3D 
• Numerous Projects (EP, EPC, EPCM) 
• All E&C offices 
• Environment  

o Segregated 
o Hosted/Remote Connect (Citrix) 
o Replicated 

2D Workshares 
• SPPID, SPI, SPEL 
• Numerous Projects (EP, EPC, EPCM) 
• Environment   

o Replicated Workshares 
o Hosted/Remote Connect (Citrix) 

Smart Plant Instrumentation 
• SPPID, SPI, SPEL 
• 9 yr history (starting with v4 INtools) 
• Use on all applicable projects 
• Use in all business Units 

o E&C 
o Fossil Power 
o Nuclear 

Current Utilization 
• 32 Current Projects 

o Full function 
o Wiring Only 
o Spec Sheets only 
o Process data only  
o 150+ users 

• Major office include Denver, Houston, Charlotte, Cambridge, 
Stoughton, Toronto, Mumbai 

Smart Plant Suite 
•  Extensive testing of Smart Plant Foundation and interaction 

with the other Smart Plant programs 
•  Out of the box testing of bi-directional data transfer between 

SPI, SPPID and SPEL through SPF 
• Starting to use all of the Smart Plant programs on various 

projects 
Future Plans 

• Centralizing all projects out of Houston with Citrix 
connections 

• Better work share 
• Easier support for limited staff 
• Utilizing on all projects where applicable regardless if 

deliverable 
• Further standardization of business unit work flows 

 
6 SPI Enhanced John Dressel delivered a presentation on SPI Enhanced Report 

Implementation – 
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  Meeting Notes 

Item Topic Notes Action/Due 
Report 
Implementation 

• Deliverable Specification Definitions SMA’s General 
Preference Setting Symbol / Title Block Citrix Sets one 
environment.  

• Location Map or Universal Locators Titleblock, Template 
layout & Symbol Gene Haney suggested arial Narrow font for 
Enhanced Smart Loops.   

• The Report Management Dialog overview he noted that 
Domain Admin Configurable you may shutdown or take 
access right away as needed say in the As Built level.   

• Wiring list or non-list, you may use filters.   
• Setting filters affect the way the any of these options are 

implemented.  
• Revision per document /per item JB or loop Top button for 

Title /Block Box.  
• Customize the Title Block Save document data and specify 

where you wish to save.   
• If you check Archive option it will increase the size of the 

saved DB.  You may wish to save to an external zip file, 
etc…  

 
7 SPI Enhanced 

Report 
Template 
Modifications  

SPI Enhanced Report Template Modifications also delivered by John 
Dressel 

• Templates are your Dwg Background. You may create your 
own custom or manipulate and existing Normal SMA 
template.  See presentation however basic procedure as 
follows: 

• Make a backup. 
• Do not copy between (Loop; Panel Strip, FieldBus; etc) 

folders, each has specific characteristics and functionality. 
• Test by creating a drawing with the modified SMA fill.  

Generate to see if modification shows up in Enhanced report.
• Background Tabs not used should be removed.  The tab at 

the far left will be the default.   
• Anchor your size i.e. Bwide, Atall, etc… 
• Set new background sheet name to be Background1.  
• Size Name is configured as Bwide this is case sensitive 
• Copy macros and graphics  
• Paste the frame in 
• Scale to proper paper size 
• Edit individual elements 
• Logo’s should be 3x1 aspect ratio pixel resolution 
• Add macros or Revision columns 
• Copy and/or modify textbox properties 
• Default – Delete old macros 
• See list of applicable macros e.g. rev_chk_by use correct 

syntax 
• There is a new Smart Text button do not use ADD MACRO 
• Group vertical lines to frame border was added by Bechtel 
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SPI Enhanced 
Report Symbol 
Modifications 

SPI Enhanced Report Symbol Modifications John Dressel 
 
Customizing existing Symbols: 

• Locate and open the file DcsDetail.sym. 
• NOTE: Sometimes locating the correct symbol file can be 

difficult.  If you are unsure of the file you need, contact others 
that can assist you.  You can NOT open the Symbol Editor if 
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  Meeting Notes 

Item Topic Notes Action/Due 
Enhanced Report Utility is open.  

• Highlight the text that you wish to move. (Notice that there 
are other fields that highlighted also.  These are the Macro’s 
that SPI will propagate when ESR drawings are created. 

• Before starting, locate and make a backup copy of the .sym 
Symbol file that you are going to modify. They can be found 
in: <SPI root directory>/RAD/Symbols 

• Additional Symbol libraries can be found in: <SPI root 
directory>/RAD/Symbols/  “Custom” and “IT”  folders 

• Locate and open the file DcsDetail.sym. 
• Highlight the text that you wish to move. (Notice that there 

are other fields that highlighted also.  These are the Macro’s 
that SPI will propagate when ESR drawings are created. 

• Once you have selected the items you wish to move, simply 
move them to their new location. 

• After they are moved, un-highlight the items by clicking an 
area outside of the object. 

• Now select save from the drop down menu at the top and 
close the Symbol Editor. 

• Check your work.  Run the appropriate Enhanced Report to 
verify that you modified symbol is correct. 

 
Creating new Symbols: 

• In this example we are going to create a new Ground symbol 
to add to the last terminal in the below image. 

• All Symbols have an “anchor point”.  This is a point that 
determines where the symbol will be placed on the drawing.  
When creating new symbols, try to use existing symbols to 
help build the new symbol.  This is because you can use the 
existing anchor point to help determine where the new 
symbol will be created.   

• In this example, we will use the existing symbol Term.sym as 
the go by.  As always, create a copy of the file you are going 
to work with, by opening it and saving it as a new file.  Lastly, 
close the Symbol Editor. 

• Creating New Symbols is NOT the same as modifying 
Symbols.  To create new Symbols, you will need to have SPI 
and the Wiring module open.  You then select Tools/Symbol 
Editor. 

• Once the Symbol Editor is open, you can then open the file 
you copied previously.  Go to File/open, navigate to the 
correct folder and select the file you copied earlier. 

• Once the file is open, notice that there is a circle with a 
crosshair.  This is the anchor point of the symbol. 

• Using the Draw functions from the Symbol Editor, start 
drawing the new ground symbol. 

• Assemble the new symbol and place it on the terminal.   
• Now Delete the terminal by selecting the lines and either 

hitting delete on your keyboard or right clicking and selecting 
delete. 

• Once the anchor point has been selected a Save As dialog 
box will appear.  Select the file path and name that you wish 
to save your new Symbol. 

• After saving your new Symbol, you will need to Assign the 
Item Type.  Select Actions/Assign Item Type. 

• Create a new Terminal type in order to use the new Symbol.  
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  Meeting Notes 

Item Topic Notes Action/Due 
From the Wiring module, select Table/Terminal/Types. 

• Select New and type in the name of the new Symbol.  This 
name must match the name of the symbol file EXACTLY. 

• Assign the new Terminal type by selecting the Terminal and 
right clicking fro properties. 

• Test the new Symbol by running the appropriate Enhanced 
Report. 
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SPI - Better 
looking 
Enhanced 
SmartLoops  

SPI - Better looking Enhanced SmartLoops Gene Haney, CB&I  
 
• Legibility has been the number one complaint with Enhanced 

SmartLoops. 
• Difficult to read full-size. 
• Impossible to read if reduced. 
• Increasing font size provides only marginal benefit. 
• Construction complained that they could not read the loop 

drawings.  
• They were using 8-1/2 x 11 reductions of an 11 x 17 ESL 

drawing.  
• No matter, we’ll find a way to take care of it! 
• Here’s the remedy . . . 
• The method used was simple, certainly not original . . . 
• Scale the titleblock down. 
• he loop graphics remain the same. 
• When printed on an 11x17 in the “Print to Fit” mode, the loop 

is significantly more legible. 
• Select and launch the Enhanced Report Utility program. 
• From the “File” drop down menu, select “Open”. 
• Drill down to the “RAD” directory and select the “Template” 

folder. 
• From the “Templates” folder, select “Types”. 
• Under “Types”, select the “loop” folder. 
• From the “loop” folder, select the “Normal.sma” file. 
• The “Normal.sma” file will open displaying the current 

“Working” sheet. 
• Select the “View” drop-down menu and change the setting to 

“Background Sheets”. 
• For 11x17 loop drawings, select the “Bwide” sheet. 
• From the “File” drop-down menu, select “Sheet Setup”. 
• In the “Sheet Setup” window, in the “Paper Units” section, the 

set the “Precision” pick list to “0.001”. 
• In the “Sheet Size” section, select the “Custom” radio button. 
• Set the width to “11.166”and the height to “7.225”. This 

represents approximately 2/3 of the full 11x17 landscape 
presentation. 

• Select “OK” to save these settings and close the “Sheet 
Setup” window. 

• The modifications made to the Background Sheet “Bwide” 
are now displayed. 

• From the “Actions” drop-down menu, choose “Scale”. (If 
Scale does not exist - check presentation on how to create) 

• In the “Scale factor” window type “0.65”. 
• The ‘scaled down’ titleblock entities will be displayed in a 

different color and can be moved as a whole to the desired 
location on the background. 

• From the “View” drop down menu, select “Working Sheets”. 
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  Meeting Notes 

Item Topic Notes Action/Due 
• From the “File” drop-down menu, select “Sheet Setup”. 
• In the “Sheet Setup” window, select the “Background” tab. 
• In the “Background Sheet” pull-down menu, select “Bwide”. 
• Click the “OK” button. 
• Save your modifications and close the Enhanced Report 

Utility program. 
• Launch the program SmartPlant Instrumentation. 
• From the “File” drop-down menu, select “Preferences”. 
• Select “Enhanced Reports” 
• Under “Enhanced Reports” select “Enhanced SmartLoop”. 
• Under “Enhanced SmartLoop” select “File Locations 
• Populate the “Template for default layout” window with the 

path to the Normal.sma file just edited. 
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Status of 
SmartPlant 
Instrumentation 

Status of SmartPlant Instrumentation Alex Koifman, Intergraph 
 

• Today’s presentation 
o SmartPlant Instrumentation v.2007 (v.8) 
o 2007 SP6 
o 2007 SP7 
o SPI v.7 
o SmartPlant Instrumentation v.2009 (v.9) 
o 2009 Sp1 and next major release 
o Intergraph 2009 conference 

 
• SmartPlant Instrumentation v.2007 

o Current status - V.2007 SP6 
o Released January 26, 2009 
o Integration: (publish PDF files generation) 
o Integration & DDP: instrument dimensions published 

in mm or in 
o Integration: Retrieve and publish process data w/o 

process case defined 
o Specs & Browsers: Cross-form specification 

browsers 
o KKS: Component classification code is not 

mandatory 
o Calibration: 7 Fluke interface enhancements (single 

point instruments, create history archive during 
upload of the results, automatically create test 
equipment, support RTD types and more) 

o DCS interfaces: Default channel attribute (DeltaV) 
o CAD Loops: Support AutoCAD 2008 (also in v.7 and 

v.2009) 
o I18N/L10N: Updated French translation 
o Need to pay attention to the Open items in the 

README, especially for O/O domain type users 
o Latest Hot fix HF3 (to be released shortly) 
o v.2007SP7, v.7 SP10 and Hot Fixes 
o V.7 SP10 planned for Q1 2010 (tentatively) 
o Hot fixes roll-up 
o Last SP for v.7 
o Will release HF’s on as needed evaluation per 

specific project/client requests 
o V.2007 SP7 planned for early 2010 (tentatively) and 

will include only roll-up of hot fixes issued for 2007 
SP6. 
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  Meeting Notes 

Item Topic Notes Action/Due 
o Hot Fixes 
o Effective February 25, 2009 latest HF’s for v.2007 

SP3 and later will be immediately available for all 
customer 

• Plans for 2009 
• Release target date – end of October 2009. 
• Emphasis is on upgrade and enhancing user experience 

compared vs. 2007 
• Noticeable items: 
• Allow adding to the line piping data 
• Publish Fieldbus tags works correctly (also in 2007 SP6 

HF2)  
• Allow selecting flow conditions (@flow, @standard, 

@normal) for instrument and DCS ranges 
• Plans for 2009 – continued 
• Noticeable items (continued): 
• Enable merging entities from the project to As Build in 

non-exclusive mode 
• Improve database security and control including 

improved encryption 
• User defined functions (substrings, left, right, etc) on ESL 

macros as exists in CAD  
• Rule Manager: Validation of condition or populate data 

via call to external application 
• Discontinue some obsolete functionality 
• Noticeable items (continued): 
• ICC Improvements supporting off-line engineering project 

execution when host is As Built domain (for initial 
customer reviews) 

• Change the database type in Oracle to allow better 
Unicode management; will improve local language 
storage (Russian, Japanese, etc) and special characters 
use including UOM’s and resolve internationalization 
issues 

• Planned discontinued functionality 
• Items planned to be discontinued in v.2009: 
• Functional Requirements specifications 
• Old DCS vendor catalogs delivered through IN_CTLOG 

and enabled in the Admin. 
• Importing from XML files  
• Unused and obsolete Telecom reports and supporting 

tables 
• Support for MicroStation 95 and PowerDraft 
• Prepare the source file in the Import module 
• Spare parts table from supplied database (functionality 

discontinued in v.7) 
• Remove DCS Card with plug in Reference Explorer 
• v.2009 SP1 
• V.2009 SP1 is planned for end of Q1 2010 and will 

include both CR’s and TR’s: 
• Reduce number of outstanding customer TR’s 
• Optional (instead of mandatory) obtain revision from SPF 

when operating in the integrated environment 
• Retrieve PIDControlFunction from SPPID into SPI as 

Soft tags 
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  Meeting Notes 

Item Topic Notes Action/Due 
• Retrieve upstream line association for relief valve from 

SPPID in integrated environment 
• Several ESL enhancements (assign layout to loop 

access rights, scale drawing, save block location in the 
Hook-up layout, custom loop generation improvements: 
Off-line Page connector reference to other loops, 
sequencing of terminals, interactive update of the custom 
symbols, split terminal strip) 

• Re-work of the NE-100 interface 
• Add Unit level folders for cables and panels 

 
• Next major release 

o Tentative planned release date – H2 2011 
o Is in early planning stages to include: 
o Continued emphasis on reducing outstanding issues 
o Business (integration, new instrumentation 

technology) 
o SPI technology and infrastructure 
o Customer input (LTUF’s) 
o Next major release considered features 
o Support wireless technology 
o Control and logic diagrams 
o Support ISO-5167-2003 for flow-meter sizing 
o Allow enabling and disabling user login into domain 

for maintenance 
o Integration with third-party (PAS, DCS vendors, 

Fluke, NE-100, etc) 
o Common navigation between schematic tools 

(SPPID, SPI and SPEL) 
o Improved support for SmartPlant Engineering 

Manager 
o … and more items are being considered. 

• Intergraph 2009 conference 
o Join us at Intergraph 2009  
o Intergraph’s International Users’ Conference  
o Washington, D.C., USA  
o June 15 - 18, 2009  
o www.intergraph2009.com  

11 CR Ranking Change Request Ranking Website Survey by all Attendees  
 
 

 

12 Forum Topics • ISA TR20 Forms for SPI Create workgroup  
• Houston LTUF Workshops Create workgroup 

 

13 Close Meeting • The next meeting will be in August at: 
Endress+Hauser 
In La Porte, TX just off Highway 225  

 
• John Dressel closed meeting 
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